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I. Introduction (and explanations)

This document explains how to prepare data for FzzPlot using MacWrite, and how to load that 
data using FzzPlot, and prepare and print a plot. This document also explains how to go in the opposite 
direction — copy a graph from FzzPlot and paste the graph into MacWrite documents, MacDraw 
drawings, or any other program that supports the pasting of graphics.

This tutorial assumes that you have some familiarity with the basic Macintosh techniques of 
pointing, clicking, and pulling down menus. If you've never used a Macintosh before, it's 
recommended that you read the Macintosh User's Guide, and that you take the Guided Tour that's 
supplied with your computer before you continue.

In addition, this document assumes that you have some familiarity with MacWrite, Apple's 
standard word processor for the Macintosh, and with MacPaint, MacDraw, or a similar drawing 
program.

While MacWrite is used to prepare the data in these examples, the techniques demonstrated here 
will work for any program that allows you to create "text-only" files — files that consist only of letters 
that you type on the keyboard, with no formatting information.

The demonstrative pictures used in this document are examples only. The images you see on 
your screen will probably be different from what's shown here, especially when you're using the 
Finder (Macintosh's file-handling application).
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II. Preparing The Data

Turn on your Macintosh, and insert a disk that has MacWrite on it. If you have a hard disk 
installed, simply turn on the computer.

After a few seconds, the Macintosh desktop will appear, with your disk icon in the upper right-
hand corner of the screen. If the disk window isn't already open, open it (either double-click on the 
disk icon or click once on the disk icon and choose "Open" from the File menu). The open disk 
window will look something like this:

Now open the MacWrite application (again, either double-click on its icon or click once in 
MacWrite's icon and choose "Open" from the File menu).

In a few seconds (less if you have a hard disk), you will see a screen that has some menus across 
the top, and a large window below the menus. This large window is an empty document, waiting for 
you to type something into it.

The first thing you should do is prepare the document's ruler so that you can easily see your 
columns of data. If you're only using two columns of data, drag a single tab out to roughly the 1/2-inch 
mark on the ruler (you can later adjust this setting, if you wish):
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 If you're using three columns of data (X value, Y value, and error value), drag two tab markers 

out: one to the 1/2-inch mark, and one to the 1-inch mark:

At this point, you're ready to type in your data. Before you start typing, some tips are in order:

• Do not put any extra letters (spaces, tabs, or otherwise) before the first number on each line. 
FzzPlot will ignore any line that does not begin with a digit, a space, a tab, or a sign (plus or minus). 
This is often a convenient feature, because you can type comments into your data file, or add blank 
lines for readability, and FzzPlot will ignore them; however, accidentally putting an extra character at 
the beginning of a line will result in mysteriously missing data points.

• When you type in the values, be sure that for each non-integer value there is at least one digit 
on each side of the decimal point. For example, the following line is incorrect:

.2415 3.0

The correct way to type this line would be:

0.2415 3.0

The exception to the rule is for integer values. This line is also a correct way to enter the data:

0.2415 3

• Both numbers in the an X-Y pair should be on the same line, and there should be only one pair 
per line. If you are using error values, each triple should be on the same line, and there should be only 
one triple per line.

Now, type in some numbers…
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Your document should now look something like this:

At this point, you can save your file. To save the information in a file that FzzPlot can read, you 
must save the file as "Text Only". First, pull down "Save" from MacWrite's File menu. MacWrite will 
display a box that lets you give a name for your file, and there are also two circular controls in the box, 
labeled "Entire Document" and "Text Only". Click in the circle labeled "Text Only". The box should 
look like this:
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Note that we've named the file "Test Data (Text)". We'll see this name again, when we open the 

file with FzzPlot.

Click on the "Save" button or press the Return Key. MacWrite will then present another box, 
asking you whether you want to put carriage returns after paragraph breaks or after line breaks:

You can click in either button, or in "Cancel" if you don't wish to save your data at all. If you 
click in the "Line Breaks" button, MacWrite will insert an extra line between each line of data in your 
file. If you click on "Paragraphs", your data will be saved exactly as it appears on the screen. Since 
FzzPlot ignores extra blank lines, whichever option you choose is purely a matter of taste.

At this point, you're done preparing data. Choose "Quit" from MacWrite's File menu. MacWrite 
will ask you if you want to save changes before quitting. Since you've already saved your data once, 
you really don't need to save any changes, unless you want another copy of your data.

If you want to skip the step of creating a separate datafile, you can copy the numbers you've 
typed in to the Clipboard, and paste them into FzzPlot. Here's how to do it:

Click the mouse once at the very beginning of your data. Next, go to the end of your data (use 
the gray scroll bar on the right edge of the document's window if you need to). Now, hold down the 
Shift key (next to the "Z" key on the left, or just below the "Return" key on the right) and click the 
mouse at the end of your data. The numbers will turn black, like this:
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Choose "Copy" from MacWrite's Edit menu, then quit MacWrite. If you want a copy of your 
data, click on the "Yes" button when MacWrite asks you whether you want to save changes. You can 
save your file as an "Entire Document"; FzzPlot won't be able to read it, but you can open the 
document again with MacWrite and copy the data out of it, if necessary.
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III. Plotting The Data

Now that you've typed in data and saved it in a file, you're ready to plot it. You'll find that 
preparing a plot of your data is quite a bit simpler than typing in the actual numbers.

First, insert a disk that has FzzPlot on it, if it isn't on a disk that you've already inserted:

Then, open the FzzPlot application icon.

FzzPlot will display an introductory dialog box. Read the contents of this box, then click "OK" 
or press the Return key to continue. Choose "Open" from FzzPlot's File menu. You'll be presented with 
a list of possible files to open. If you had to eject the disk that had your original data file on it, and you 
have a single-drive Macintosh, click on the "Eject" button, remove the FzzPlot disk (the system will 
ask for it when it needs it), and insert the disk that has your datafile on it. Once the disk with the 
datafile is inserted, the list will look something like this:

To open our sample datafile, either double-click on its name, or click once on its name and click 
on the "Open" button or press the Return key.

FzzPlot will spring into action, and will display a series of small boxes to let you know what it's 
doing, and the cursor will spin while it's performing those actions, so that you know the computer is 
functioning, and that it didn't "hang up" trying to read your data.

After a few seconds, a window will appear on the screen that has your data plotted in it.

If you have copied your data to the clipboard (as described above), you don't need to choose 
"Open". Instead, choose "Paste" from the Edit menu. FzzPlot will behave exactly as if it is loading a 
text file, except that the window will be titled "Data From the Clipboard".



From Data To Plot: A Tutorial Page 

9
And here's our graph:

More than likely, the graph doesn't look like you want it to. To help relieve this problem, 
FzzPlot offers a set of formatting commands. These commands all reside under the Display menu. 
Here's a quick walk-through of the Display menu, and some things to try on your graph:

• "Axis Labels" lets you change the axis and plot titles. When you choose this command, 
FzzPlot brings up a dialog box like this:
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When a text box (a rectangle with letters in it) is completely black, you can replace what's 

already in there simply by typing. Press the Tab key to move to the next text box in line. For example, 
press the Tab key twice to move to the third item in the list (it's the plot title, labeled "Plot:"), and type 
in a new title for your plot.

• "Axis Limits" allows you to narrow the axis limits to view a smaller slice of your data, or 
expand the limits. You can also set the number of displayed decimal places for the tick mark labels. 
(Initially, these are displayed as integers; see "Graph Formats", below.) Clicking in the button labeled 
"Defaults" will automatically scale the plot (which is done when a plot is created).

• "Set Plot Type" lets you choose the type of plot you want; either a column graph (for 
histograms) or a scatter graph. When you're plotting a scatter graph, you can display dots to denote the 
data points (when printed on a LaserWriter, the dots appear as small filled circles, while on the 
ImageWriter and the Macintosh screen, they appear as squares), you can connect the data points with 
straight lines, or you can display error bars. If you have no error values in your datafile, this last option 
will be gray, and clicking on it has no effect. The dialog box looks like this:

Note that you can switch an option on and off by repeatedly clicking in it. When there's an X in 
the box, it's switched on, when the box is empty, it's off.

Try switching on "Connect Points", then click "OK".
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• "Plot Information" allows you to add some information to the printed output that isn't 

displayed on the screen with the plot. Initially, the switches are set so that the date, time, name of the 
datafile, and statistical information are all printed out with the plot. The box to change the settings 
looks like this:

As in the Plot Type box, click in a box to change its setting.

• "Number Formats" gives you finer control over the displayed precision of the tick mark labels, 
and of the statistics results. You can use the scroll bars to set the number of places you wish to display; 
if you set the check box labeled "Scientific Notation" next to a scroll bar, that scroll bar's setting will 
be ignored, and the tick mark labels (or statistics) will be displayed in a fixed-point notation: two 
significant figures, plus a power-of-ten exponent. Note that the tick labels will be displayed as integers 
unless the "Label Ticks with Integral Values Only" check boxes are not set in the Graph Formats 
dialog box (see the next paragraph). The Number Formats box looks like this:
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If you click in the button labeled "Defaults", the settings will be set to 3 places for the 
regression results, and to 2 decimal places for the axes.
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• "Graph Formats" lets you add some features to your graph. The check boxes are set in the 
fashion previously described. If part of your dataset in not suitable for plotting on a log-scaled axis, the 
check box corresponding to that axis will be disabled and turned gray. An additional note: if the check 
box labeled " Label Ticks with Integral Values Only" are set, then only tick marks whose values would 
be integers will have labels, and all other ticks will not have a label. For example, if a tick mark has a 
label value of 15.9, then if the "Label Ticks with Integral Values Only" switch for that axis is set, the 
tick mark will not have a label. However, if the tick mark has a label value of 16.0, then it will be 
labeled with "16". Try changing this setting to see the effect. This is the dialog box:

These 6 dialog boxes allow you to format your plot. The next step is to print the plot out. There 
are two steps to doing this. First, choose "Page Setup" from the "File" menu:
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This dialog box is for the ImageWriter printer; the box for the LaserWriter is different. The 
essentials are the same: settings for paper size, special effects and orientation. When you're printing 
out a plot, it's recommended that you set the orientation to the "Landscape" (sideways) setting. On the 
Page Setup box above, the setting is for "Portrait" (upright) orientation; click on the icon next to the 
highlighted icon to set the Landscape setting. If the orientation is set for Landscape, the printout will 
be closer in scale to the Macintosh screen; plots printed out with Portrait orientation will be stretched 
vertically. An additional tip: do not change the reduction settings, no matter what printer you choose. If 
you want to reduce the printed size of you plot, copy the graph and paste it into MacDraw, and scale it 
there. See "Copying the Graph", page 15, for more details…

The next step in the process is to print out the graph. Simply choose "Print…" from the "File" 
menu. A dialog like this one will be displayed:

Set the settings to your taste; if you want multiple copies, change the value in the "Copies:" text 
box. The "Page Range" settings should be left alone; their value has no effect on what comes out of the 
printer. Click "OK" to start the printing process. A message will be displayed while the printing is in 
progress, and the cursor will spin briefly while the graph is drawn on the printer. At any time during 
this process you can cancel the printing process by holding the Command key (just to the left of the 
space bar) and typing a Period (.) .
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Copying The Graph

FzzPlot has the ability to copy any graph on the screen to the Clipboard. This ability is quite 
useful; for example, you might want to include a graph in a report or presentation document. Or, you 
may wish to copy a graph to MacDraw to put the axis labels into a different font, and perhaps rotate 
the vertical axis label, since FzzPlot doesn't know how to rotate text or do multiple fonts (yet). 

The copying process is quite simple. First, create and format your graph as described on the 
previous pages. Then choose "Copy Graph" from the Edit menu, and your graph is copied to the 
Clipboard. That's it! There are some things to take note of:

• FzzPlot copies your graph to the Clipboard in the exact size that it's displayed on the 
Macintosh screen; this means that if you copy a plot window that is 3 inches on a side, and paste the 
graph into MacDraw, the graph you paste will be only 3 inches on a side. Conversely, a plot window 
that fills a large screen such as the Radius FPD™, which measures 81/2 x 11 inches, will, when pasted 
into MacDraw, measure 81/2 x 11 inches.

• Graphs are copied to the Clipboard as "pictures"; this means that you can resize a graph once 
it's been pasted, and it will still be printed out smoothly on a LaserWriter (or other high-resolution 
printer) with no loss of detail. The drawback of this scheme is that very large graphs (more than 2000 
points) can take up large amounts of memory while in the Clipboard, and MacDraw will take a long 
time to redraw a graph once you've pasted it.
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IV. Conclusion

And that's all there is to it! FzzPlot has many more capabilities, and you can learn about those 
capabilities by consulting the FzzPlot Reference, which gives a detailed description of all of FzzPlot's 
features, as well as some useful technical tips. You can (and should) experiment with the various 
switches and options. You can't break anything, and you can't damage your data in any way by 
experimenting.

After experimenting with FzzPlot for a while, you've probably come across a feature of FzzPlot 
(or part of the documentation) that confuses you, or is inconsistent, or just plain irritating. My main 
gripe is that the vertical axis label is not rotated or positioned correctly; fortunately, that can be 
remedied by copying the graph, pasting it into MacPaint or MacDraw, selecting the axis label, and 
rotating it. Future versions of FzzPlot will fix this problem.

If you have other problems, don't hesitate to write. I value user feedback, good or bad.

——————
Finder, MacWrite, MacPaint, MacDraw, Macintosh, ImageWriter, and LaserWriter are all trademarks
of or licensed to Apple Computer, Inc.

The Finder, MacWrite, MacPaint, and MacDraw are all programs copyrighted by Apple Computer, Inc.

FPD (Full Page Display) is a trademark of Radius.

FzzPlot is copyrighted ©1986, 1987 by Richard M. Siegel, all rights reserved.
FzzPlot uses standard Pascal libraries and intrinsics supplied with the Lightspeed™ Pascal
development environment; these libraries and intrinsics are copyright ©1986 by THINK Technologies, Inc;
420 Bedford St, Lexington, Mass. 02173

It's not a bug, it's a feature!


